Savant Pro Lamp Control
SAV-LMP-0300

Deployment Guide
Document Number: 009-1388-01
Document Date: August 2016
Document Supports: da Vinci 8.0
Important Safety Information

Before installing, configuring, and operating Savant® equipment and other vendor equipment, Savant recommends that each dealer, installer, etc. access and read all the required technical documentation. Savant technical documentation can be located by visiting the Savant Community. Vendor documentation is supplied with the equipment.

Read and understand all safety instructions, cautions, and warnings in this document and the labels on the equipment.

Safety Classifications in this Document

<table>
<thead>
<tr>
<th>Note:</th>
<th>Provides special information for installing, configuring, and operating the equipment.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IMPORTANT!</strong></td>
<td>Provides information critical to installing, configuring, and operating the equipment.</td>
</tr>
<tr>
<td><strong>CAUTION!</strong></td>
<td>Provides special information on avoiding situations that may cause damage to equipment.</td>
</tr>
<tr>
<td><strong>WARNING!</strong></td>
<td>Provides special information on avoiding situations that may cause physical danger to the installer, end user, etc.</td>
</tr>
</tbody>
</table>

Electric Shock Prevention

⚠️ **ELECTRIC SHOCK!** The source power poses an electric shock hazard that has the potential to cause serious injury to installers and end users.

⚠️ **ELECTRICAL DISCONNECT:** The source power outlet and power supply input power sockets should be easily accessible to disconnect power in the event of an electrical hazard or malfunction.

Weight Injury Prevention

⚠️ **WEIGHT INJURY!** Installing some of the Savant equipment requires two installers to ensure safe handling during installation. Failure to use two installers may result in injury.

Safety Statements

Follow all of the safety instructions listed below and apply where applicable. Additional safety information will be included where applicable.

1. Read these instructions.
2. Keep these instructions.
3. Heed all warnings.
4. Follow all instructions.
5. Do not use this apparatus near water.
6. Clean only with a dry cloth.
7. Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.
8. Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The wide blade or the third prong is provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
9. Plug into a surge protected outlet or receptacle.
10. Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as power supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.
11. To completely disconnect this equipment from the AC mains, unplug from the outlet or receptacle.
# Contents

To access the link to the topics in this document, click the topic page.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Important Safety Information</td>
<td>2</td>
</tr>
<tr>
<td>1. Introduction</td>
<td>4</td>
</tr>
<tr>
<td>2. Deployment Steps</td>
<td>5</td>
</tr>
<tr>
<td>3. Lamp Control Overview</td>
<td>6</td>
</tr>
<tr>
<td>4. Connections</td>
<td>7</td>
</tr>
<tr>
<td>5. Provisioning to the Network - SmartConnect</td>
<td>9</td>
</tr>
<tr>
<td>5.1 Required Items for Network Configuration</td>
<td>9</td>
</tr>
<tr>
<td>5.2 SSID Guidelines</td>
<td>9</td>
</tr>
<tr>
<td>5.3 Provisioning Steps - SmartConnect</td>
<td>10</td>
</tr>
<tr>
<td>6. Understanding Bindings</td>
<td>12</td>
</tr>
<tr>
<td>7. RacePoint Blueprint® Configuration - Bind through SmartConnect</td>
<td>13</td>
</tr>
<tr>
<td>7.1 Enable Controller Functionality on the Host</td>
<td>13</td>
</tr>
<tr>
<td>7.2 Configure Blueprint to Access Lighting/Keypad Manager</td>
<td>13</td>
</tr>
<tr>
<td>7.3 Lighting/Keypad Manager Basics</td>
<td>14</td>
</tr>
<tr>
<td>7.4 Lighting/Keypad Manager - Add Lamp Control</td>
<td>14</td>
</tr>
<tr>
<td>7.5 Lighting/Keypad Manager - Load Scenes (Optional)</td>
<td>15</td>
</tr>
<tr>
<td>7.6 Populate/Update the Lighting Data Table</td>
<td>17</td>
</tr>
<tr>
<td>7.7 Upload Configuration</td>
<td>18</td>
</tr>
<tr>
<td>7.8 Bind Lamp Control Using SmartConnect</td>
<td>19</td>
</tr>
<tr>
<td>7.9 Unbind Process</td>
<td>21</td>
</tr>
<tr>
<td>7.10 Export Configuration File</td>
<td>22</td>
</tr>
<tr>
<td>8. RacePoint Blueprint® Configuration - Bind through Lighting Manager</td>
<td>23</td>
</tr>
<tr>
<td>8.1 Enable Controller Functionality on the Host</td>
<td>23</td>
</tr>
<tr>
<td>8.2 Configure Blueprint to Access Lighting/Keypad Manager</td>
<td>23</td>
</tr>
<tr>
<td>8.3 Lighting/Keypad Manager Basics</td>
<td>24</td>
</tr>
<tr>
<td>8.4 Lighting/Keypad Manager - Add Lamp Control</td>
<td>24</td>
</tr>
<tr>
<td>8.5 Lighting/Keypad Manager - Load Scenes (Optional)</td>
<td>25</td>
</tr>
<tr>
<td>8.6 Lighting/Keypad Manager - Establish Bindings</td>
<td>27</td>
</tr>
<tr>
<td>8.7 Populate/Update the Lighting Data Table</td>
<td>29</td>
</tr>
<tr>
<td>8.8 Upload Configuration</td>
<td>30</td>
</tr>
<tr>
<td>Appendix A: Network Requirements</td>
<td>32</td>
</tr>
<tr>
<td>Appendix B: Provision to the Network - Web UI</td>
<td>33</td>
</tr>
<tr>
<td>Appendix C: Firmware Info</td>
<td>35</td>
</tr>
<tr>
<td>Appendix D: Additional Procedures</td>
<td>36</td>
</tr>
<tr>
<td>Configure Lamp Control to Function as a Switch</td>
<td>36</td>
</tr>
<tr>
<td>Important Notice</td>
<td>37</td>
</tr>
<tr>
<td>FCC Regulatory</td>
<td>38</td>
</tr>
</tbody>
</table>
1. **Introduction**

This Deployment Guide will guide the installer through the process of installing, configuring, and adding a Savant Lamp Control (SAV-LMP-0300) to a Savant Control system.

**Before You Begin**

Read through this document in its entirety and ensure that the following required items are available:

- Savant Lamp Control (SAV-LMP-0300)
- Savant Smart or Pro Host licensed in Savant Control system running da Vinci 8.0 or higher
- Savant Development Environment (SDE) MacBook®
- Smart Connect Application (v1.5 or higher) installed on an iOS device
- Network meeting Savant Requirements
- SSID and Passphrase for the Wi-Fi® Router or Switch
- **Optional:** Unique ID (UID) of the Lamp Control
2. **Deployment Steps**

Follow these steps to successfully deploy the Savant Lamp Control. This page can be used as a checklist to record which steps have been completed.

- Review the Lamp Control connections and controls
  - See Lamp Control Overview

- Connect hardware
  - See Connections

- Provision Lamp Control onto network using SmartConnect
  - See Provision to the Network - SmartConnect

- Add Lamp Control to a Blueprint configuration and Bind
  - See RacePoint Blueprint Configuration - Bind through SmartConnect
    - or -
  - RacePoint Blueprint Configuration - Bind through Lighting Manager
3. **Lamp Control Overview**

The Lamp Control is powered when plugged into any overcurrent protected 120V AC outlet and will remotely control the load/light plugged into its output receptacle.

<table>
<thead>
<tr>
<th>Bulb Type</th>
<th>Power Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incandescent/ Halogen</td>
<td>250W max / 5W min</td>
</tr>
<tr>
<td>Dimmable CFL</td>
<td>100W max / 5W min</td>
</tr>
<tr>
<td>Dimmable LED</td>
<td>100W max / 5W min</td>
</tr>
</tbody>
</table>

**IMPORTANT NOTE!** Do not use CFL or LED bulbs listed as **Not for use with dimmers**.

Refer to the Lamp Control Quick Start Guide (009-1406-xx) for this product located on the [Savant Community](#) for Box Contents and Specifications.
4. **Connections**

Prior to configuring the Lamp Control into RacePoint Blueprint, it can be connected and tested to verify the lamp can be toggled on and off.

1. Plug the Lamp Control directly into an overcurrent protected 120V AC receptacle/outlet.

![Image of Lamp Control plugged into outlet](image)

2. Plug the cord from a lamp into the receptacle on the Lamp Control. Turn the Lamp Switch to the On position.

![Image of Lamp Control with cord plugged in](image)

3. Verify the LED on the side of the Lamp control is blinking yellow (factory default setting). See **Blinks Once (Yellow)** in the *LED Status* section below.

![Image of Lamp Control with LED flashing yellow](image)

Blinking yellow indicates the Lamp Control is in Access Point Provisioning Mode. This is how the Lamp Control is configured when leaving the factory. If it is not blinking yellow, press and hold the reset button for 5 seconds until the LED blinks red then release. See **Rapid Blink (red)**.

4. Press and release the reset button positioned on the bottom of the Lamp Control. Verify the lamp/load toggles On and Off. The Lamp Control is now ready to be provisioned.

![Image of Lamp Control with reset button](image)
LED Status
Before provisioning the Lamp Control, refer to the table below for info on the Status LED and Reset button.

The table below shows the various states the Lamp Control can get into.

<table>
<thead>
<tr>
<th>State LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off: No Power.</td>
<td></td>
</tr>
<tr>
<td><strong>On Solid (Green):</strong></td>
<td>Connected to the network and bound to the configuration running on the</td>
</tr>
<tr>
<td></td>
<td>Savant Control System Host.</td>
</tr>
<tr>
<td><strong>On Solid (Yellow):</strong></td>
<td>Lamp Control is booting after being reset.</td>
</tr>
<tr>
<td><strong>On Solid (Red):</strong></td>
<td>Error Mode caused by an over current condition. When this occurs, unplug the</td>
</tr>
<tr>
<td></td>
<td>Lamp Control, wait ten seconds and plug back in. This will reset the error</td>
</tr>
<tr>
<td></td>
<td>condition.</td>
</tr>
<tr>
<td><strong>Blinks Once (Yellow):</strong></td>
<td>In Access Point Provisioning Mode and ready to be provisioned to the</td>
</tr>
<tr>
<td></td>
<td>local network.</td>
</tr>
<tr>
<td><strong>Blinks Once (Green):</strong></td>
<td>Provisioned and communicating with the local network. Not currently</td>
</tr>
<tr>
<td></td>
<td>communicating with the Savant Control System Host (Not bound to the Host).</td>
</tr>
<tr>
<td><strong>Rapid Blink (Red):</strong></td>
<td>The reset button was held down for at least five seconds. When button is</td>
</tr>
<tr>
<td></td>
<td>released, the rapid blink will stop and the Lamp Control will reset into</td>
</tr>
<tr>
<td></td>
<td>Access Point Provisioning Mode.</td>
</tr>
<tr>
<td><strong>Rapid Blink (Yellow):</strong></td>
<td>When activating the locate feature, the LED will blink yellow as shown</td>
</tr>
<tr>
<td></td>
<td>below. Refer to the TIP in the Provisioning Steps – SmartConnect section.</td>
</tr>
<tr>
<td><strong>Blinking Yellow/Green:</strong></td>
<td>Firmware is updating</td>
</tr>
</tbody>
</table>

Reset Button
- Positioned on the bottom of the Lamp Control.

**Press and Hold:**
While powered On, press and hold for five seconds until the Status LED begins blinking red, then release (See **Rapid Blink (Red)**). After the Lamp Control resets, it will be set to Access Point Provisioning Mode.

**Press and Release:**
Press and release the reset button to toggle the load on and off (provisioned or not).
5. Provisioning to the Network - SmartConnect

Prior to adding the Lamp Control into a configuration in RacePoint Blueprint, the Lamp Control must first be provisioned to the local network. To do this, Savant offers the SmartConnect Application, which is available for download from the iTunes App store. The SmartConnect application makes it simple to provision the Lamp Control to the network as well as a host of other tasks. Using SmartConnect is described in this section.

If however, the SmartConnect Application is not available, the Lamp Control can also be provisioned using the embedded Web UI. To provision using the embedded Web UI, refer to Appendix B: Provisioning – Web UI.

The next few steps describe how to provision using the Smart Connect application.

⚠️ IMPORTANT NOTES!
- SmartConnect version 1.5 or higher.
- Bluetooth version 4.0 or higher.

5.1 Required Items for Network Configuration

The following items are required to provision the Lamp Control to the network using the Smart Connect application.

- iOS Device with SmartConnect (v1.5 or higher) App installed
- Lamp Control
- SSID and Passphrase for the Wireless router or switch
- Network meeting the Savant Network Requirements

(See Appendix A: Network Requirements)

5.2 SSID Guidelines

Savant Wi-Fi products can connect to a wireless network that meets the following SSID guidelines.

- Maximum SSID Length: 32 characters
- Maximum Passphrase Length: WPA/WPA2: 8-50 characters
  WEP: 10-26 characters
- Wireless Standard: 802.11 b/g/n 2.4 GHz

Supported SSID and Passphrase Special Characters

! # @ $ % ^ & * ( ) _ ` ~
= + , ; : ? / \ [ ] { } | \ /
5.3 Provisioning Steps – SmartConnect

Provisioning the Lamp Control using the SmartConnect application (v1.5 or higher) is described below.

1. Refer to the Connections section above for initial setup and testing information. If the Lamp Control is already set up, skip that section and proceed to step 2 below.

2. By default, a new Lamp Control is set at the factory to be in Access Point Provisioning Mode. See Blinks Once (Yellow). If it is, skip this step and proceed to step 3 below. If the Lamp Control is in some other state than Access Point Provisioning Mode follow the bulleted steps below to set it to this mode.

   • Insert a pointed object such as a paper clip into the reset button pinhole. Press and hold the reset button for five seconds until LED blinks red, then release.
   • After the reset, the LED will switch to solid yellow while the Lamp Controller boots.
   • After approximately 5-10 seconds, the LED on the side of the Lamp Control starts blinking yellow once per second indicating it is in Access Point Provisioning Mode and ready to be provisioned to the local network.

Refer to the LED Status section for LED state info.

3. On the iOS device (iPad®, iPhone® etc.), open the SmartConnect Application.

4. Locate the Lamp Control in the Devices on Bluetooth section of SmartConnect.

5. Tap the Lamp Control from the Devices on Bluetooth dialog window.

   TIP! If there are multiple Lamp Controls offered in SmartConnect and the UID of the Lamp Control is unknown, SmartConnect can be used to locate the Lamp Control. To do this, tap one of the Lamp Control devices offered under the Devices on Bluetooth heading. The Status LED on the side of the Lamp Control device will begin to blink rapidly (yellow) for 5-7 seconds and if there is a lamp connected, the lamp will flash 5-7 times with the LED. If this is not the intended Lamp Control, tap Cancel in the Pick a Network window that opens. Continue till the Lamp Control you would like to provision is located.

6. In the Pick a Network dialog window that opens, tap the Join Other Network... selection (image not shown).

7. In the Other Network dialog window that opens (shown below), enter the following:
   
   **Name** – Enter SSID of the network.
   
   **Security** - Tap Choose in the Security field and select the security configured in the local network.
   
   **Password** - Enter Password to the local network.

   TIP! Tap the Use Current Network SSID field to auto populate the Name field with the SSID of the local network.

8. Tap Join when complete.
A **Provisioning Success** dialog window will open informing the user that the device successfully provisioned to the network. Tap **OK**.

The **Provisioning Success** dialog box:

- **Provisioning Success**
  - The device was successfully provisioned
  - **OK**

The Lamp Control is now provisioned to the local network. The LED on the side of the Lamp Control will now blink green indicating it is connected to the network but has not established a binding to the Savant Pro System. Refer to the **LED Status** section for LED state information.

**Additional Information**

- The provisioned Lamp Control will now be displayed in the **Devices on Wi-Fi** section of SmartConnect.

The next step is to configure the Lamp Control into RacePoint Blueprint and bind to the Savant Pro System.
6. Understanding Bindings

Before starting the binding process, it is important to understand what binding a lighting device to the Savant Pro System involves. Binding or unbinding a lighting device is adding or removing the UID of the lighting device to the configuration running on the Savant Pro System Host.

There are numerous methods available to the integrator to bind a lighting device to the Savant Pro System. They are as follows:

A. Bind Lighting Device using SmartConnect

The first method involves the use of an iOS device with the SmartConnect application installed. This is the recommended method and is described in the Section 7: RacePoint Blueprint Configuration – Bind through SmartConnect. Establishing the bindings with SmartConnect requires a user to carry an iOS device such as an iPhone® to each lighting device, push a button on the lighting device, and accept the UID that appears in the SmartConnect application.

HELPFUL INFORMATION!! Establishing the bindings using SmartConnect adds the UID of the lighting device to the configuration running on the Pro System Host. To retrieve a configuration file with the UIDs added to the file itself, the file must be exported from the Host as described in section 10 below. Any future edits to the configuration can now be modified in the exported file using RacePoint Blueprint and eventually uploaded to the Host.

B. Bind Lighting Device using the Web UI through System Monitor

The second method involves the use of the SDE/MacBook with the System Monitor application installed. Establishing the bindings through System Monitor requires a user to carry around the SDE/MacBook to each lighting device, push a button on the lighting device, and accept the UID that appears in the Web UI. The steps required are similar to the SmartConnect method above but requires carrying a bulkier SDE/MacBook with System Monitor loaded. Follow the steps in Section 7: RacePoint Blueprint Configuration – Bind through SmartConnect. The only difference between Method A and Method B is the tool used to establish the bindings. As described in the Helpful Information note above, this method requires the file to be exported after the bindings are established.

C. Bind Lighting Device using the Bind button in RacePoint Blueprint

The third method binds the keypads using the Bind button located in the Lighting Manager of RacePoint Blueprint. In the Keypads tab of the Lighting and Keypad Manager a Bind button is available. This method gives a user the ability to establish the bindings prior to uploading the configuration to the Pro System Host. This method requires the user to select the Bind button, push a button on the lighting device, and accept the UID that appears in the RacePoint Blueprint binding window. Once all bindings are established, the file can be saved and then uploaded to the Host. Follow the steps in Section 8.6 Lighting/Keypad Manager – Establish Bindings for the steps required.

HELPFUL INFORMATION!! Establishing the bindings using the Bind button adds the UID directly to the configuration file that will be sent to the Pro System Host. The user does not have to export the file from the Host to retrieve a file that includes the UID as required in methods A and B.

D. Bind Lighting Device using UID field in Keypads tab in RacePoint Blueprint

The fourth method binds the keypads using the UID field in the Keypads tab of the Lighting Manager. If the UID does not appear when pressing the Bind button (method C above) then the UID of the Lamp Control can be manually entered. Once entered the file can be uploaded to the Host. Follow the steps in Section 8.6 Lighting/Keypad Manager – Establish Bindings for the steps required.

HELPFUL INFORMATION!!

- An example of why the UID does not appear when pressing the Bind button in method C above would be if the SDE/MacBook and Lamp Control were not on the same network.
- The UID of the Lamp Control can be retrieved through either the SmartConnect or rpm EmbScanner tool.
7. **RacePoint Blueprint® Configuration - Bind through SmartConnect**

Add the Lamp Control to RacePoint Blueprint and then bind to the Savant Pro System using SmartConnect is described in this section.

**IMPORTANT!** If establishing the bindings through RacePoint Blueprint, skip this section and proceed to Section 8.

### 7.1 Enable Controller Functionality on the Host

By default, the Lighting Controller Source function is NOT enabled in the Savant Pro System Host. To enable, do the following:

1. Open the Smart or Pro Host Inspector (Double-click the Host in RacePoint Blueprint).
2. Select Resources from the Show: drop-down menu.
3. Enter a check into the Lighting Controller Source field (Default Mode is unchecked).
4. Close the Inspector

### 7.2 Configure Blueprint to Access Lighting/Keypad Manager

The color of the State icon in the RacePoint Blueprint toolbar indicates if the Lighting/Keypad Manager can be accessed.

- **Orange or Red** - The Lighting/Keypad Manager is grayed out and not active.
- **Green or Blue** - The Lighting Manager is active and can be opened.

No Lighting Services have been generated and the Lighting/Keypad Manager is grayed out and not accessible. Select **Generate Services** from the toolbar to generate the lighting services and the Lighting/Keypad Manager will become active.

**TIP!** If this is a lighting only configuration, the following steps will make the Lighting/Keypad Manager active.

1. Drag the Smart or Pro Host into the Layout window.
2. Locate the **Generic NetworkSwitch** in the Component Library. Drag it into the Layout window.
3. Connect the **Ethernet(Ethernet)** port on the Smart or Pro Host to the **Generic NetworkSwitch**. The State icon will change from red to orange and the Generate Services icon will become active.
4. Select **Generate Services** icon.

The State icon changes from orange to either blue or green and the Lighting/Keypad Manager will become active.

Services are generated and the Lighting/Keypad Manager is active and accessible.
7.3 Lighting/Keypad Manager Basics

The Lighting/Keypad Manager (Tools > Savant Lighting and Keypads) has three tabs:

- **Wi-Fi Lighting Devices**
  - Add the Lamp Controller to RacePoint Blueprint.
  - Label the Lighting Device and/or Loads.
  - Configure a Location for each Lamp Control.

- **Lighting Scenes**
  - Modify the load scenes that are generated when the Lamp Control is created (Optional).
  - Create a custom load scene and assign to the Lamp Control (Optional).

- **Keypads**
  - The Keypads tab is used only when the Lamp Control bindings are established using the RacePoint Blueprint application. Otherwise, this tab is not used.

7.4 Lighting/Keypad Manager - Add Lamp Control

The Lamp Control as well as any Lighting device is added into RacePoint Blueprint from within the Wi-Fi Lighting Devices tab. Follow the steps below to add the Lamp Control to the Lighting/Keypad Manager.

1. Select **Tools > Savant Lighting and Keypads** to open the Lighting/Keypad Manager.
2. Select the **Wi-Fi Lighting Devices** tab.
3. Select the icon to open the Wi-Fi Lighting Devices window.
4. Under the **# to Add** column, double-click the field associated with the Lamp Control and enter the number of Lamp Control(s) being added (see image below).

5. Select the **Add** button to add the Lamp Control to the Blueprint configuration (See image above). The number of Lamp Controls entered is added to the Lighting/Keypad Manager (See image below). Label and configure the Lamp Control(s).

6. Save the configuration (**File > Save** from the Blueprint menu bar).

Double-click and enter the number of Lamp Controls

Select Add

Enter a name that identifies where the Lamp Control is located. The identifier should make it easy to find the Lamp Control when entering the room selected in the Location column described below. To modify, double-click to highlight and enter the new name.

Enter a name that identifies where the load plugged into the Lamp Control is located. The identifier should make it easy to locate the lamp/load when entering the room specified in the Location column. To modify, double-click the text and enter a new identifier. The name entered will also be displayed in the TrueControl II or Savant Pro App as the device being controlled.

Select from the drop-down menu, the room or zone where the Lamp Control is located.

Displays the layout of the Lamp Control and cannot be modified.
7.5 Lighting/Keypad Manager – Load Scenes (Optional)

When a Lamp Control is added to the Lighting/Keypad Manager, a load scene for that device is automatically generated. The load scene created is by default associated with the Lamp Control added. If modifications to the parameters of the load scene are required, they are modified from within the Lighting Scenes tab described in sections 7.5.1 and 7.5.2 below.

If the load scene is not being modified, skip sections 7.5.1 and 7.5.2 and proceed to section 7.6 below.

7.5.1 Modify a Load Scene

To modify a load scene, follow the steps below.

1. Select the Lighting Scenes tab.
2. Select the Show Load Scene check box in the bottom left corner of the Lighting Scenes window that opens. Adding a check to this box will display the load scene(s) generated in the Scene panel.

**HELPFUL INFORMATION!** Selecting Show Load Scenes check box described above is because any load scenes generated when adding a lighting device are not initially displayed.

3. In the Scene panel, select the load scene for the Lamp Control added.
4. Modify the fields in the Dimmer tab as required. Use the descriptions in the table below.

<table>
<thead>
<tr>
<th>Dimmer</th>
<th>Where the load scene settings for a dimmer type device are modified.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimmer State</td>
<td>Sets the maximum amount of power (in %) that can be applied to the Lamp Control.</td>
</tr>
<tr>
<td>Min % / Max%</td>
<td></td>
</tr>
<tr>
<td>Min: %</td>
<td>- Sets the minimum amount of power (in %) required to turn on the load plugged into the Lamp Control.</td>
</tr>
<tr>
<td>Max: %</td>
<td>- Sets the maximum amount of power (in %) required to light the load to its full capacity.</td>
</tr>
</tbody>
</table>

*With these two fields set correctly, the output power sent to the lamp plugged into the Lamp Control is more granular and the power curve more linear. These fields may need adjustments because of the different types of lamps available (LED, Incandescent, CFL).*

**Auto-Correction Functions:**
The Lighting/Keypad Manager has auto correction software built into it so the values set can never exceed the predetermined limits set.

- The Dimmer State can’t be set lower than the Min: % value or higher than the Max: % value. If the value in the Dimmer State field is outside these parameters, an alert is displayed:

  ![Alert](The value 50 is too small. The value 91 is too large.)

- If the Min: % value is set higher than the Dimmer State value the Lighting/Keypad Manager adjusts the value to match the Min: % value set.
- If the Max: % value is set lower than the Dimmer State, the Lighting/Keypad adjusts the value to match the Max: % value set.

| Fade On | Sets the time (seconds) it takes for the power applied to the load to increase to the Max: % value set. |
| Fade Off | Sets the time (seconds) it takes for the power applied to the load to decrease to Off. |
### 7.5.2 Scene Settings Panel

To the right of the Default Load Settings panel is the Scene Settings panel. Refer to descriptions below and configure as required.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hold Cycle Time</td>
<td>Sets the time it takes for a command to complete when a button is pressed and held. For example, if set to 10 seconds, it will take 10 seconds for the load to ramp from 0 to the preset level set in the load scene.</td>
</tr>
<tr>
<td>Scene is Active</td>
<td>Sets the feedback or response observed in the TrueControl II or Savant Pro 8 App. For example, if set to Exact, the feedback observed in the Savant Pro 8 or TrueControl II App follows how the setting Exact will react.</td>
</tr>
</tbody>
</table>
### Populate/Update the Lighting Data Table

Once the Lamp Control(s) are added and configured, the information needs to be populated in the lighting data table. Follow the steps below to do this.

1. Select the **Sync** button in bottom right corner of the Keypads tab and the dialog window shown below opens.

![Sync Data Table for Controller: Savant Pro Host](image)

When the box is selected it will add/transfer entries in the lighting data table to match the current wireless lighting configuration. When de-selected it will delete any entries in the lighting data table that were created as a result of the wireless lighting configuration.

- **Loads**
- **Scenes**
- **Load Scenes**
- **Buttons**
- **Reset any user modifications**

2. Using the descriptions below, check or uncheck the appropriate boxes.

   **Checked** - An entry in the lighting data table associated with the checked box gets created or updated.
   
   **Unchecked** - Any entry in the lighting data table associated with the unchecked box does not get created or updated. If there was an entry from a previous Sync operation when the box was checked, the entry associated with the unchecked box is removed. This is true for multiple entries as well.

![HELPFUL INFORMATION!](image)

HELPFUL INFORMATION! When updating or creating a lighting data table, it is recommended that a check be added to only the Loads and Scenes boxes. Each box checked adds additional buttons and icons to the Savant Pro 8 or TrueControl II Apps. Adding a check to the Load Scenes and Buttons boxes are typically used when troubleshooting.

- **Checked** - Any user modifications made are discarded. Any boxes checked (Loads, Scenes, Load Scenes, Buttons) will cause the entry in the lighting data table to revert to the default values.
- **Unchecked (Default)** - Any user modifications made to the data table are transferred to the lighting data table. For this to occur, the boxes described above (Loads, Scenes, Load Scenes, Buttons) that are associated with the updates must be checked.

3. Select the **Sync** button to update the lighting data table with an updated configuration.

**IMPORTANT!** The data table that gets modified only affects the TrueControl II and Savant Pro 8 Apps. Any modifications made here do not affect the Lamp Control configurations.

4. After the Sync button is pressed, the updated lighting data table opens as displayed below.

![Updated Lighting Data Table](image)

5. Select Done when Complete.

6. Select the **Generate Services** icon in the Blueprint toolbar. The State icon will change to blue or green indicating the services for the Lamp Control has been created.

7. Select **Update All UI Screens > Sync with Services** from the Blueprint toolbar to sync the user interfaces such as the iPad* to the Services created. The State icon will change to green when complete.

8. Select **File > Save** from the Blueprint menu bar.
7.7 **Upload Configuration**

After the Lamp Control is added to Blueprint and configured, the configuration with the Lamp Control information can be uploaded to the Host.

1. To upload the configuration, select the **Upload to Master** icon from the Blueprint toolbar and send the configuration to the Host.

2. In the **Configuration must be saved** dialog window that opens, read the dialog and select **Save and Upload**.

3. The System Monitor application will automatically open as displayed below. Verify the path to the configuration file is correct. Select **Upload** when satisfied.

The configuration will now upload to the Host and the Host will begin communicating with the Lamp Control. The Status LED on the side of the Lamp Control will illuminate solid (green) indicating it is connected to the network and bound to the configuration running on the Host.
7.8  **Bind Lamp Control Using SmartConnect**

Once the configuration is uploaded to the Host, the Lamp Control bindings can now be established.

Before beginning the process, verify the following:

- The Lamp Control is provisioned and communicating with the local network.
- The Lamp Control is configured in RacePoint Blueprint and the configuration was uploaded to the Pro System Host.

**Tools Required**

- iOS device such as an iPad® or iPhone® that supports Bluetooth V4.0 with the Savant SmartConnect application installed.

### 7.8.1 Download and Install SmartConnect

If the SmartConnect Application is not installed on your iOS device, it can be downloaded from the Apple App Store. To find the SmartConnect App on the App store, search for **Savant SmartConnect**. Once located, download to your iOS device. The SmartConnect Application automatically gets installed once downloaded.

### 7.8.2 Bind Process (Bind to Configuration on Host)

1. Connect the iOS device to the network that the Savant Pro System Host is connected to.

2. Tap the icon to open the SmartConnect application.

3. Locate the Smart or Pro Host (Savant ID) from the list of devices under the **Devices on WiFi** section. Tap the Host Controller to open the devices page.

4. On the Devices page that opens (image below), the Lamp Control will be available. A question mark in the field indicates the Lamp Control is not bound to the configuration running on the Host. Tap the Lamp Control to open the Device Binding page.

   ![Device Binding Page](image)

   **INDICATES DEVICE IS NOT BOUND**

5. A Device Binding page opens (image below) and requests: Push a button on the physical device you would like to bind to this keypad.

   ![Device Binding Page](image)

   Using a small pointed object such as a paper clip, press and release the reset button positioned at the bottom of the Lamp Control. Once pressed, the UID for the device being bound is displayed on the Device Binding page. See image in step 6 below.
6. Tap the UID that appeared. This binds the Lamp Control to the configuration running on the Host. The LED on the side of the Lamp Control will now be on solid green indicating it is connected to the network and bound to the configuration running on the Host.

7. Verify the device is bound by tapping the **Flash Last** icon. The lamp plugged into the Lamp Control will flash three times and the Status LED on the Lamp Control will blink yellow each time the Lamp flashes. This indicates the Lamp Control is configured and communicating with the Host.

8. Select the **<Back** button and repeat steps above to bind all Lamp Controls in the configuration to the Savant Control System Host.
7.9 **Unbind Process**
There are some scenarios such as when a Host or Lamp Control is being replaced; the Lamp Control needs to be unbound from the configuration running on the Host before binding the new Lamp Control device.

1. Connect the iOS device to the wireless network that the Savant Control system is utilizing.
2. Open the SmartConnect application.
3. Locate the Smart or Pro Host (Savant ID) from the list of devices under the **Devices on WiFi** section. Tap the Host Controller to open the devices page.
4. In the Devices page that opens, tap the **Lamp Control** to open the Device Control page.
5. Tap the **Device Binding** tab on this page.

6. In the Device Binding page that opens, tap **Unbind**.

7. An **Unbind Keypad?** window will open. Read the dialog and tap **Unbind Device** if OK to unbind.

8. The Lamp Control will no longer be bound to the Host and a new Lamp Control can be added.
7.10 Export Configuration File

After binding the Lamp Control to the configuration running on the Savant Pro System Host, Savant recommends that the configuration file with all the bindings be exported, saved, and then reloaded onto the Host. The configuration file currently loaded on the Host does NOT include the bindings. To get a configuration file that includes the bindings, the configuration with its bindings needs to be exported from the Host.

1. On the SDE/MacBook, open the System Monitor application.
2. Within System Monitor, select and highlight the Host from the list of hosts displayed.
3. Once highlighted, select **Get Config** from the System Monitor toolbar.

4. A drop-down dialog window will open. Browse to and save the configuration to a pre-determined directory.

The file will get saved as a `<config_file>.tgz` file

⚠️ **Important!**

If there are any updates made to the bindings after the file has been exported, either the exported file will need to be updated or the updated configuration with the updated bindings will need to be exported again.
8. RacePoint Blueprint® Configuration - Bind through Lighting Manager
Add, Configure, and Bind the Lamp Control using the RacePoint Blueprint application is described in this section.

8.1 Enable Controller Functionality on the Host
By default, the Lighting Controller Source function is NOT enabled in the Savant Pro System Host. To enable, do the following:

1. Open the Smart or Pro Host Inspector (Double-click the Host in RacePoint Blueprint).
2. Select Resources from the Show: drop-down menu.
3. Enter a check into the Lighting Controller Source field (Default Mode is unchecked).
4. Close the Inspector

8.2 Configure Blueprint to Access Lighting/Keypad Manager
The color of the State icon in the RacePoint Blueprint toolbar indicates if the Lighting/Keypad Manager can be accessed.

Orange or Red - The Lighting/Keypad Manager is grayed out and not active.
Green or Blue - The Lighting Manager is active and can be opened.

No Lighting Services have been generated and the Lighting/Keypad Manager is grayed out and not accessible. Select Generate Services from the toolbar to generate the lighting services and the Lighting/Keypad Manager will become active.

TIP! If this is a lighting only configuration, the following steps will make the Lighting/Keypad Manager active.

5. Drag the Smart or Pro Host into the Layout window.
6. Locate the Generic NetworkSwitch in the Component Library. Drag it into the Layout window.
7. Connect the Ethernet(Ethernet) port on the Smart or Pro Host to the Generic NetworkSwitch. The State icon will change from red to orange and the Generate Services icon will become active.
8. Select Generate Services icon.

The State icon changes from orange to either blue or green and the Lighting/Keypad Manager will become active.

Services are generated and the Lighting/Keypad Manager is active and accessible.
8.3 Lighting/Keypad Manager Basics

The Lighting/Keypad Manager (Tools > Savant Lighting and Keypads) has three tabs:

- **Wi-Fi Lighting Devices**
  - Add the Lamp Controller to RacePoint Blueprint.
  - Label the Lighting Device and/or Loads.
  - Configure a Location for each Lamp Control.

- **Lighting Scenes**
  - Modify the load scenes that are generated when the Lamp Control is created (Optional).
  - Create a custom load scene and assign to the Lamp Control (Optional).

- **Keypads**
  - The Keypads tab is used only when the Lamp Control bindings are established using the RacePoint Blueprint application. Otherwise, this tab is not used.

8.4 Lighting/Keypad Manager - Add Lamp Control

The Lamp Control as well as any Lighting device is added into RacePoint Blueprint from within the Wi-Fi Lighting Devices tab. Follow the steps below to add the Lamp Control to the Lighting/Keypad Manager.

1. Select Tools > Savant Lighting and Keypads to open the Lighting/Keypad Manager.
2. Select the Wi-Fi Lighting Devices tab.
3. Select the icon to open the Wi-Fi Lighting Devices window.
4. Under the # to Add column, double-click the field associated with the Lamp Control and enter the number of Lamp Control(s) being added (see image below).
5. Select the Add button to add the Lamp Control to the Blueprint configuration (See image above). The number of Lamp Controls entered is added to the Lighting/Keypad Manager (See image below). Label and configure the Lamp Control(s).

6. Save the configuration (File > Save from the Blueprint menu bar).
8.5 Lighting/Keypad Manager – Load Scenes (Optional)
When a Lamp Control is added to the Lighting/Keypad Manager, a load scene for that device is automatically generated. The load scene created is by default associated with the Lamp Control added. If modifications to the parameters of the load scene are required they are modified from within the Lighting Scenes tab described in sections 8.5.1 and 8.5.2 below.

If the load scene is not going to be modified, skip sections 8.5.1 and 8.5.2 and proceed to section 8.6 below.

8.5.1 Modify a Load Scene
To modify a load scene, follow the steps below.

1. Select the Lighting Scenes tab.
2. Select the Show Load Scene check box in the bottom left corner of the window. Adding a check to this box will display the load scene generated in the Scene panel.

⚠️ HELPFUL INFORMATION! Load scenes generated when adding a lighting device are not initially displayed.

3. In the Scene panel, select the load scene for the Lamp Control added.
4. Modify the fields in the Dimmer tab as required. Use the descriptions in the table below.

<table>
<thead>
<tr>
<th>Dimmer</th>
<th>Where the load scene settings for a dimmer type device is modified.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimmer State</td>
<td>Sets the maximum amount of power (in %) that can be applied to the Lamp Control.</td>
</tr>
<tr>
<td>Min %</td>
<td>Sets the minimum amount of power (in %) required to turn on the load plugged into the Lamp Control.</td>
</tr>
<tr>
<td>Max %</td>
<td>Sets the maximum amount of power (in %) required to light the load to its full capacity.</td>
</tr>
</tbody>
</table>

With these two fields set correctly, the output power sent to the lamp plugged into the Lamp Control is more granular and the power curve more linear. These fields may need adjustments because of the different types of lamps available (LED, Incandescent, CFL).

Auto-Correction Functions:
The Lighting/Keypad Manager has auto-correction software built into it so the values set can never exceed the predetermined limits set.

- The Dimmer State can’t be set lower than the Min: % value or higher than the Max: % value. If the value in the Dimmer State field is outside these parameters, an alert is displayed.

  ![The value 50 is too small.](image)

  ![The value 91 is too large.](image)

- If the Min: % value is set higher than the Dimmer State value the Lighting/Keypad Manager adjusts the value to match the Min: % value set.

- If the Max: % value is set lower than the Dimmer State, the Lighting/Keypad adjusts the value to match the Max: % value set.

<table>
<thead>
<tr>
<th>Fade On</th>
<th>Sets the time (seconds) it takes for the power applied to the load to increase to the Max: % value set.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fade Off</td>
<td>Sets the time (seconds) it takes for the power applied to the load to decrease to Off.</td>
</tr>
</tbody>
</table>
8.5.2 Scene Settings Panel

To the right of the Default Load Settings panel is the Scene Settings panel. Refer to descriptions below and configure as required.

**Hold Cycle Time**
Sets the time it takes for a command to complete when a button is pressed and held. For example, if set to 10 seconds, it will take 10 seconds for the load to ramp from 0 to the preset level set in the load scene.

**Scene is Active**
Sets the feedback or response observed in the TrueControl II or Savant Pro 8 App. For example, if set to Exact, the feedback observed in the Savant Pro 8 or TrueControl II App follows how the setting Exact will react.
8.6 Lighting/Keypad Manager – Establish Bindings

Establishing bindings using RacePoint Blueprint Bind button and the UID field of the Lighting Manager are described below. Decide which process works best for you situation.

Bind using the Bind button

1. Verify sections 8.1 through 8.5 above are completed.
2. From the Lighting/Keypad Manager, select the Keypads tab (see image below).
3. Select the Lamp Control from the list of lighting devices (see image below).
4. Select the Bind button at the bottom of the Lighting/Keypad Manager (see image below).

![Select Bind](image)

Selecting the Bind button will open the drop-down bind window shown in image below.

5. Using a small pointed object such as a paper clip, press and release the button positioned on the bottom of the Lamp Control. This adds the UID of the Lamp Control to the bindings window (See image below).

![Select Bind Once UID Appears](image)

6. Select the Bind button (see image above) and the Lamp Control will bind itself to the configuration file in RacePoint Blueprint. Repeat steps 3-6 above and bind all the Lamp Controls. Close Lighting and Keypad Manager when done.
**Bind using the UID Field**

Establishing the bindings using the UID field in RacePoint Blueprint is described below. This process is typically used if the Bind/Un-Bind button process described above does not work. This process manually enters the UID into the configuration running in RacePoint Blueprint.

Prior to starting the process, the user must obtain the UID of the Lamp Control. To get the UID, the SmartConnect application must be used. Open the SmartConnect application and copy the UID of the Lamp Control. Refer to Provisioning Steps – SmartConnect for information on getting the UID.

1. Verify sections 8.1 through 8.5 above are completed.
2. From the Lighting/Keypad Manager, select the **Keypads** tab (see image below).
3. Select the Lamp Control from the list of lighting devices (see image below).
4. Double-click the UID field and enter the UID of the Lamp Control (see image below).

![UID Entry Image](image)

5. Repeat steps 3 and 4 above and add the UID to the UID field of all the Lamp Controls in the lighting devices list. Close Lighting and Keypad Manager when done.

The next step is to populate/update the lighting data table. Continue to section 8.7 below.
8.7 Populate/Update the Lighting Data Table

Once the Lamp Control(s) are added and bound to the configuration file the lighting data table in RacePoint Blueprint can be updated. Follow the steps below to do this.

1. Select the [button in bottom right corner of the Keypads tab and the dialog window shown below opens.]

2. Using the descriptions below, check or uncheck the appropriate boxes.

   **Checked** - An entry in the lighting data table associated with the checked box gets created or updated.

   **Unchecked** - Any entry in the lighting data table associated with the unchecked box does not get created or updated. If there was an entry from a previous Sync operation when the box was checked, the entry associated with the unchecked box is removed. This is true for multiple entries as well.

   **HELPFUL INFORMATION!** When updating or creating a lighting data table, it is recommended that a check be added to only the Loads and Scenes boxes. Each box checked adds additional buttons and icons to the Savant Pro 8 or TrueControl II Apps. Adding a check to the Load Scenes and Buttons boxes are typically used when troubleshooting.

   **Checked** - Any user modifications made are discarded. Any boxes checked (Loads, Scenes, Load Scenes, Buttons) will cause the entry in the lighting data table to revert to the default values.

   **Unchecked (Default)** - Any user modifications made to the data table are transferred to the lighting data table. For this to occur, the boxes described above (Loads, Scenes, Load Scenes, Buttons) that are associated with the updates must be checked.

3. Select the [Sync button to update the lighting data table with an updated configuration. After the Sync button is pressed, the updated lighting data table opens as displayed below.

   **IMPORTANT!** The data table that gets modified only affects the TrueControl II and Savant Pro 8 Apps. Any modifications made here do not affect the Lamp Control configurations.

4. Select **Done** when Complete.

5. Select the **Generate Services** icon in the Blueprint toolbar. The State icon will change to blue or green indicating the services for the Lamp Control has been created.

6. Select **Update All UI Screens > Sync with Services** from the Blueprint toolbar to sync the user interfaces such as the iPad® to the Services created. The State icon will change to green when complete.

7. Select **File > Save** from the Blueprint menu bar.
8.8 Upload Configuration

Once the RacePoint Blueprint configuration is complete, the file can be uploaded to the Host. Follow steps below to do this.

1. To upload the configuration, select the **Upload to Master** icon from the Blueprint toolbar and send the configuration to the Host.

![Select Upload to Master](image)

2. In the **Configuration must be saved** dialog window that opens, read the dialog and select **Save and Upload**.

![Configuration must be saved](image)

3. The System Monitor application will automatically open as displayed below. Verify the path to the configuration file is correct. Select **Upload** when satisfied.

![System Monitor](image)

The configuration will now upload to the Host and the Host will begin communicating with the Lamp Control. The Status LED on the side of the Lamp Control will illuminate solid (green) indicating it is connected to the network and bound to the configuration running on the Host.
Additional Documentation

Additional documentation is available on the Savant Community.

- Metropolitan Wireless Lighting Deployment Guide (009-1342-xx)
- Savant University > Course Catalog > Lighting - Lighting Tutorial Videos
- Lighting Data Tables Overview: Application Note in the Savant Community.
- Lighting Data Table: Application Note in the Savant Community.
Appendix A: Network Requirements

Savant requires the use of business class/commercial grade network equipment throughout the network to ensure the reliability of communication between devices. These higher quality components also allow for more accurate troubleshooting when needed.

Connect all Savant devices to the same local area network (LAN) or subnet as the host. Savant recommends not implementing any type of traffic or packet shaping in your network topology for the Savant devices as this may interfere with performance.

Network Configuration
To ensure that the IP Address will not change due to a power outage, a static IP Address or DHCP reservation should be configured. Savant recommends using DHCP reservation within the router. By using this method, static IP Addresses for all devices can be managed from a single UI avoiding the need to access devices individually.

Setting DHCP reservation varies from router to router. Refer to the documentation for the router to configure DHCP reservation.

Network Changes
It is good practice to reboot (power cycle) the Lamp Control after changing routers, or if the IP address range is changed in the current router.

To Reboot the Lamp Control:
- Cycle Power
  Unplug the Lamp Control from the wall. Wait 15 seconds and plug back into outlet.

To Reset to Factory Defaults
- Press & Hold the Reset Button on the bottom side of the Lamp Control for 5 seconds until the Status LED starts a rapid blink (red). Release the Reset button once the rapid blink begins. Allow 10-15 seconds for the controller to reset. See the LED Status section for LED state information.
If the SmartConnect application is not available, the Lamp Control can be provisioned using the embedded Web UI in the Lamp Control.

1. Refer to the Connections section above for initial setup and testing information. If the Lamp Control is already set up, skip that section and proceed to step 2 below.

2. By default, a new Lamp Control is set at the factory to be in Access Point Provisioning Mode. See Blinks Once (Yellow). If it is, skip this step and proceed to step 3 below. If the Lamp Control is in some other state than Access Point Provisioning Mode follow the bulleted steps below to set it to this mode.

   • Insert a pointed object such as a paper clip into the reset button pinhole. Press and hold the reset button for five seconds until LED blinks red, then release.
   • After the reset, the LED will switch to solid yellow while the Lamp Control boots.
   • After approximately 5-10 seconds, the LED on the side of the Lamp Control starts blinking yellow once per second indicating it is in Access Provisioning Mode and ready to be provisioned to the local network.

3. On the MacBook/SDE, select the Wi-Fi icon in the menu bar and select the Lamp Control from the available networks. The Lamp Control will appear as Savant[Mac Address]. The Mac Address is the first 12 characters of the Savant UID.

4. In the address bar of a browser, enter the following IP Address: 192.168.1.1

5. Select Provisioning to display a list of available networks.
6. In the list of available networks, select the network to connect.

![Provisioning Screen]

**Note:** Refer to the Other SSID section below if your network is not in the list of available networks.

7. Follow the prompts and enter the Passphrase to the network selected.

8. Once connected, a verification message will appear.

![Success Message]

Other SSID:

- In step 6 above, if the desired network does not appear in the list, it can be manually configured to a network by selecting Other SSID at the bottom of the list of available networks screen and follow the prompts.

![Other SSID Option]

- Select Other SSID if the local network does not appear in the list of available networks

9. The Lamp Control is now provisioned to the local network. The LED on the side of the Lamp Control will now blink green indicating it is connected to the network but has not established a binding to the Savant Pro System. Refer to the LED Status section for LED state information.

**Additional Information**

- The Status LED on the Lamp Control will now blink green once per second. This indicates it is provisioned to the local network but not bound to the configuration running on the Host.

- The Lamp Control will now be displayed in the Devices on Wi-Fi section in SmartConnect.
Appendix C: Firmware Info

Firmware updates are automatic and occur each time the software is updated on the Savant Control System Host. After a software upgrade, the Host scans the network and compares the firmware version loaded in the Lamp Control with the firmware in the updated da Vinci software. If an update is available, the update process will begin automatically at that time.

Additional information on the **Firmware Upgrade Status** and **Firmware Revision** currently installed on the controller can be accessed through the System Monitor Application.

**System Monitor > WiFi Lighting > Settings > Firmware Upgrade**

Below is the Firmware Upgrade page:
Appendix D: Additional Procedures

Configure Lamp Control to Function as a Switch
Follow the steps described below to configure the Lamp Control to operate as an On/Off switch. The procedure assumes the Lamp Control has already been added to the configuration and is working as a Dimmer.

1. Open the RacePoint Blueprint configuration.
2. Open the Lighting Manager from the menu bar (Tools > Savant Lighting and Keypads).
3. Select the Lighting Scenes tab (see image below for steps 3-7).
4. Select the Show Load Scene check box so that all the load scenes are displayed under the Scene window.
5. Select the Lamp Control load scene. In this example, the Corner Lamp Scene is associated with the Lamp Control.
6. Modify the Min and Max values of this load scene to 100%.
7. Select the Sync... button and follow the prompts to update the lighting data table with the changes made.

8. During the Sync operation, the lighting data table opens. Locate the Lamp Control being modified. Change the value in the Entity column of the Lamp Control from Dimmer to Switch (see image below).

9. Select Done when complete.
10. Select Generate Services from the RacePoint Blueprint toolbar and follow the prompts.

HELPFUL INFORMATION! After Generating the Services, the State Icon in the RacePoint Blueprint toolbar changes to green, verify the Lamp Control in the lighting data table is still set to switch (Tools > Settings > Lighting).

11. Upload the updated file to the Savant Pro System Host.
12. Test and verify the Lamp Control now has switch (On/Off) controls in the Savant Remote and the Savant Pro 8 App. Selecting On or Off now toggles the load On and Off.
Important Notice

Disclaimer
The contents of this document are subject to change without notice; therefore, the information presented herein shall not be construed as a commitment or warranty.

Savant Systems, LLC shall not be liable for any technical or editorial errors or omissions contained herein or for incidental or consequential damages resulting from the performance, furnishing, reliance on, or use of this material.

Patents
Certain equipment and software described in this document is protected by issued and pending U.S. and foreign patents.

All products and services are trademarks or registered trademarks of their respective manufacturer.

Copyright
This document contains confidential and proprietary information protected by copyright. All rights reserved. Copying or other reproduction of all or parts of this document is prohibited without the permission of Savant Systems.

Trademarks
© 2016 Savant Systems, LLC. All rights reserved. Savant, Savant App, Savant Host, Now You Can, RacePoint Blueprint, Single App Home, TrueCommand, TrueControl, and the Savant logo are trademarks of Savant Systems, LLC.

AirPlay, Apple, AirPort Express, AirPort Extreme, Apple TV, Apple Remote Desktop, FireWire, iMac, iTunes, iPad, iPad mini, iPad Air, iPhone, MacBook, Mac and OS X are trademarks or trade names of Apple Inc. iOS is a trademark of Cisco®. Android, Google, Google Play, and other Google marks are trademarks of Google, Inc. Wi-Fi is a registered trademark of the Wi-Fi Alliance®. HDMI® is a trademark of HDMI Licensing, LLC.

All other brand names, product names, and trademarks are the property of their respective owners.

Technical Support
Savant Systems, LLC is dedicated to providing prompt and effective support in a timely and efficient manner.

- To contact Savant Support, access the Savant Community and enter a support case ticket.
- To contact Savant Sales, visit Savant.com and select Contact Us to locate a local sales representative in your area.
**FCC Regulatory**

This device complies with Part 15 of the FCC Rules and Regulations. For complete information, refer to the Savant Important Information document supplied with the Lamp Control.

Contains FCC ID: TLZ-CU277

Contains IC: 6100A-CU277